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1. Introduction

HREM-Filters Pro/Lite is a plug-in for use in Gatan’s DigitalMicrograph for
Windows v.3.8 or later. However, we will recommend you to use the latest
version.

This HREM-Filters Pro/Lite User’s Guide is written to provide information on
the basic functions of the HREM-Filters Pro/Lite software, a procedure for
installation of the Plug-In, some general tips on operation. This Guide
assumes the user is familiar with image manipulation using DigitalMicrograph
as well as Windows operating system.

Note: HREM-Filters Lite is free software, so anyone can use this software
without a license. However, HREM Research Inc. does not renounce a
copyright of this software.

Technical Support
General enquiries on the HREM-Filters should be sent to:

HREM Research Inc.
Email: support@hremresearch.com
Web: www. hremresearch.com

Copyright Statements

© Copyright 2006-2020 HREM Research Inc.
All rights reserved. This manual is protected by international copyright laws
and treaties. Unauthorized reproduction and distribution of this manual, or any

portion of it, will be prosecuted to the maximum extent possible and may result
in severe civil and criminal penalties.

DigitalMicrograph is a trademark of Gatan Inc.
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2. Installation

This chapter describes hardware and software requirements to run the
HREM-Filters Pro/Lite plug-in and an installation procedure of the plug-in.

2.1 Requirements

The HREM-Filters Pro/Lite plug-in runs under DigitalMicrograph
environment, and the software and hardware requirements are similar to those
for DigitalMicrograph itself.

2.1.1 Hardware requirement

The HREM-Filters Pro is commercial software and thus requires a license key
(a USB dongle), while the HREM-Filters Lite is free software and thus requires
no license key.

2.1.2 Software requirement
The following is a list of the software requirements necessary to run the
HREM-Filters Pro/Lite plug-in:
® DigitalMicrograph for Windows.
® USB Key Driver (only required for HREM-Filters Pro)
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2.2 Software Installation

The following modules should be installed. Please consult the ReadMe file for

installation. The following modules should be placed in the folder “Pluglns” on

the same level of the DigitalMicrograph.

® HREM-Filters Pro or HREM-Filters Lite Plug-in (.gtk and .dll)

® HREM Mouse Tool Plug-in (Free-ware available at
www.hremresearch.com)

® [PU Plug-in (only required for HREM-Filters Pro; Free-ware
available at www.hremresearch.com)

® USB Key Driver (only required for HREM-Filters Pro)

Note: The Pluglns folder should exist under a normal installation of the
DigitalMicrograph.

Installing HREM-Filters Pro or HREM-Filters Lite Plug-in
HREM-Filters Pro or HREM-Filters Lite (.gtk and .dll) can be installed by
drag-and-drop copy to the folder “Pluglns” on the same level of the
DigitalMicrograph.

Installing HREM Mouse Tool Plug-in
This is a free plug-in. Please download the plug-in from the Scripts/Plugins
page and install it according to the ReadMe file.

Installing IPU Plug-in

This is a free plug-in. Please download the plug-in from the Scripts/Plugins
page and install it according to the ReadMe file. This plug-in is required by
HREM-Filters Pro in order to extend Fourier transform capability. However,
anyone can use the IPU Plug-in to calculate Fourier transform of an arbitrary
sized image.

When the DigitalMicrograph is launched after placing the plug-ins the Pluglns
folder, HREM-Filters Pro/Lite menu (Filters) commands will be appeared
under “Filters” menu and the Mouse tool will be appeared as an addition to the
standard tools.

Installing Key Driver

The user key driver should be installed by following the instructions given by
the key driver installer (only required for HREM-Filters Pro). The key
driver installer comes with HREM Filters Pro, or you can find it on our web
site.
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3. Getting Started...

Using the HREM-Filters Pro/Lite is very simple. All the operations are menu
driven, and process the front active image. This chapter briefly explains each
command.

3.0 Essentials

3.0.1 Noise model
The noise model is very important to extract a signal from a noisy image.
Thus, HREM-Filters Pro supports two noise models: Amorphous noise and
Random noise. Here, the amorphous noise means the noise from non-periodic
substrate (amorphous material), while the random noise corresponds to white
noise or statistical noise (Poisson noise).

The amorphous model will use a smoothed background in Fourier space, and
be applicable for the most of the cases. However, the random model will be
useful for an ADF STEM image or an elemental map, where the statistical
noise is significant.

How amorphous noise model works

The background of the filter for the amorphous noise model is estimated as a
lower-bound of the image spectrum. During the filter operation only the
spectrum that is higher than the background is contribute the filtered image.
Thus, the amorphous noise model will effectively extract a periodic structure.

However, non-periodic structures, such as a grain boundary or defect(s), will
contribute to the image spectrum in the similar way that amorphous material
contribute to the image background. Thus, such non-periodic structure will be
washed out using the amorphous noise model.

How random noise model works

The filter based on the random noise model adopts an iferative procedure,
where the low-frequency information is protected by Gaussian low-pass filter,
and the rest of information is passed to the Wiener/Difference filter. Then, the
noise in higher frequency component will be progressively removed, while
keeping the low frequency components as much as possible. Therefore, the
filter based on the random noise will keep non-periodic structures more than
the filter based on the amorphous model. Furthermore, you can choose the best
one from the output stack, since this filter is iterative.
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3.0.2 Resolution and Information Limit

The concept of Information Limit is important to filter-out the noise in keeping
signal information in the image. Here, we assume that all the signal information
exist only within the Information Limit as shown in the example below:

TiO2 nano-particles Fourier transform

Resolution and Information Limit are closely related. If you change one value,
the other value will be changed. When the image is calibrated, you will see a
physical unit for Resolution. If not, the unit of Resolution is pix (pixels). When
you know the resolution of the micrograph in a physical unit or in pixels, you
can directly input the value for Resolution. Alternatively, you can input the
value for Information Limit in terms of the Maximum Frequency of the Fourier
transform.

Filter Options X

Resolution: pix
Information Limit: x Maximum Frequency QU[GEIS

Remove High Frequencies outside the Information Limit

Smooth Edge By: x Information Limit

The default value of the Information Limit is 0.5. If the circle is too small or
too large, you can adjust the radius of the circle by changing the value of the
Information Limit. When you change the value for Resolution or Information
Limit, it is advisable to push Update button to confirm its size in the Fourier
transform.

If you want, you can remove high frequencies outside the Information Limit,
which corresponds to high-frequency noise.
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The Information Limit is essential for the Random Noise model, since the
Low-pass Gaussian width is defined in terms of the Information Limit.

Filter Options X

PN GI s GIERNGIEC Random Noise

lteration Cycle:
Output @ Every Cycle
@® LastCycle

Resolution: EXi} pix

Information Limit: b E Ul CLTEL AN Update

Low-pass Gaussian Width (Sigma): x Information Limit

Since the random noise model works iteratively, there are some patemeters to

be specified.
Iteration Cycle: This determines the maximum number of iterations
Output: This specified the cycle of result outputs or the output

only at the last cycle.
Low-pass Gaussian The half-width of the smoothing Gaussian in Fourier
Width (Sigma): space is specified here.

TIPS: Usually, the low-pass Gaussian width of one (1.0) will be acceptable,

and the maximum iteration of ten (10) with the outputs at every two (2) cycle
will be sufficient.
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3.1 HREM-Filters

Local 2D Wiener Filter (Pro)...
2D Wiener Filter (Pro)...
Radial Wiener Filter...

Local 2D Difference Filter (Pro)...
2D Difference Filter (Pro)...

Radial Difference Filter...

Refine Motif (1st xCorr) (Pro)...
Average good Motifs (2nd xCorr) (Pro)...

Realtime Upsampling Filter...

Create Upsampled Image...

Periodic Filter » Find Base Vectors
Adaptive Wiener Filter... Apply Mask... (Pro)

Replace Dud Pixels...
Trend Subtract
Radial Average

Help >
About Filters...

HREM-Filters Pro/Lite Menu.

The commands with (Pro), such as Local 2D Wiener Filter (Pro), indicate that
they are available only for HREM-Filters Pro. Other commands can be used by
both Pro and Lite versions, although some capabilities indicated by (Pro Only)
in the dialog are applicable only for HREM-Filters Pro.
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We will use the following image of crysotile, a clay minerals, taken by Prof.
Kogure, Univ. of Tokyo. This is not an ideal crystal showing a simple
translational symmetry, and thus clearly shows a power of Filters Pro.

Original Image (crysotile) Fourier transform
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3.1.1 Radial Wiener/Difference Filter

A background in Filter is estimated by radial average of Fourier transform of
the whole area.

Filter Options X

Resolution: EXi pix

Information Limit: x Maximum Frequency JUELGEIS]

Remove High Frequencies outside the Information Limit
Smooth Edge By: x Information Limit
Show Background
Show Mask

@ Simple Radial Background (e.g.. Kilaas)
O Advanced Radial Background (Pro only)

Enhanced background (Pro only) m x random (white) noise std
Trend Subtract (Pro only)
Fourier Transform Display Mode: © Modulus (Amplitude)
@ Log of Modulus

Upsampling (Pro only) by

Resolution When you know the resolution of the micrograph in a
physical unit or in pixels, you can directly input the
value here. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

Information Limit: The Information Limit given by a fraction of the
Maximum Frequency of the image.
Update By clicking the Update button, you can verify the

Information Limit on the power spectrum.
When you change the value of the resolution or
information limit, click this button to check the size of
the circle on the power spectrum.

Remove High Frequencies outside the Information Limit

Smooth Edge By:  If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge).

Show Background: If checked, the background of the Wiener/Difference
filter will be displayed.

Show Mask: If checked, the Wiener/Difference filter mask will be
displayed.
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Radial Background
type:

Enhanced background
(Pro only)

Trend Subtract (Pro
Only):

Fourier Transform
Display Mode
Upsampling (Pro only)

The choice of the type of Radial Background. Lite can
use Simple Radial Background obtained by rotational
average of the intensity (e.g., Kilaas).

Advanced Radial Background that is available for Pro
only is a smooth version of the Simple Radial
Background. Usually, this background is far superior
to the Simple Radial Background.

If checked, the background is increased by the factor
multiplied by the std of the random noise.

If checked, the trend of the original image is subtracted
before Wiener filtering, and put back afterward.

You can select the display mode between Modulus
(Amplitude) and Log of Modulus.

If checked, the filtered image will be up-sampled by
the selected factor.

Radial Wiener filtered image Difference from the original image
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3.1.2 2D Wiener/Difference Filter (Pro Only)

There are two noise models: Amorphous noise and Random noise.

3.1.2.1  Amorphous noise

A smoothed two-dimensional trend of Fourier transform of the whole
area is used as a background in Filter for the amorphous noise.

Filter Options X

Amorphous Noise BEERTIRNGIES

Resolution: EXi pix

Information Limit: b TN G TEL I Update

Remove High Frequencies outside the Information Limit
Smooth Edge By: x Information Limit
Show Background
Show Mask

SE G [elIils R Ts 1M Amplitude ~

Enhanced background x random (white) noise std

SN El 4 Image Trend v
Upsampling by

Fourier Transform Display Mode: Q) Modulus (Amplitude)
@ Log of Modulus

Resolution When you know the resolution of the micrograph in a
physical unit or in pixels, you can directly input the
value here. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

Information Limit: The Information Limit given by a fraction of the
Maximum Frequency of the image.
Update By clicking the Update button, you can verify the

Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click this button to check the size of
the circle on the power spectrum.
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Remove High Frequencies outside the Information Limit

Smooth Edge By:  If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge)

Show Background: If checked, the background of the Wiener/Difference
filter will be displayed.

Show Mask: If checked, the Wiener/Diffrence filter mask will be
displayed.

Background Model: The background of the filter will be estimated from the
amplitude or the intensity.

Mode: The choice of the 2D background estimation scheme
from Quick and Elaborate.

Enhanced background If checked, the background is increased by the factor
(Pro only) multiplied by the std of the random noise.
Subtract: Image trend/Gaussian blurred image

If checked, the image trend or Gaussian blur of the
original image is subtracted before Wiener/ Difference
filtering, and put back afterward.

Upsampling (Pro only) If checked, the filtered image will be up-sampled by
the selected factor.

Fourier Transform You can select the display mode between Modulus

Display Mode (Amplitude) and Log of Modulus.

2D Wiener filtered image Difference from the original image
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3.1.2.2 Random noise

Filter Options

Amorphous Noise

Backgro

Random Noise

lteration Cycle:

Information Limit: x Maximum Frequency JU[GEIG

Low-pass Gaussian Width (Sigma): x Information Limit

Remove High Frequencies outside the Information Limit

Smooth Edge By: x Information Limit

Show Background
Show Mask

(G Amplitude v
Upsampling by

Fourier Transform Display Mode: © Modulus (Amplitude)

Output © EveryCycIe
@® LastCycle

Resolution: XY

pix

@ Log of Modulus

I N

Iteration Cycles:

Output:

Resolution:

Information Limit:

Update

Low-pass Gaussian
Width (Sigma):

This determines the maximum number of iterations

This specified the cycle of result outputs or the output
only at the last cycle.

When you know the resolution of the micrograph in a
physical unit or in pixels, you can directly input the
value here. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

The Information Limit given by a fraction of the
Maximum Frequency of the image.

By clicking the Update button, you can verify the
Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click this button to check the size of
the circle on the power spectrum.

The half-width of the smoothing Gaussian in Fourier
space is specified here. A large Gaussian width
requires a longer iteration.
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Remove High Frequencies outside the Information Limit

Smooth Edge By:

Show Background:

Show Mask:

Background Model:

Upsampling

Fourier Transform
Display Mode

If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge)

If checked, the background of the Wiener/Difference
filter will be displayed.

If checked, the Wiener/Difference filter mask will be
displayed.

The background of the filter will be estimated from the
amplitude or the intensity.

If checked, the filtered image will be up-sampled by
the selected factor.

You can select the display mode between Modulus
(Amplitude) and Log of Modulus.
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3.1.3 Local 2D Wiener/Difference Filter (Pro Only)

A background in Filter is locally estimated by smoothed two-dimensional
trends of Fourier transform of finite areas. The size of the area is controlled by
the Width parameter below.

Filter Options X

Amorphous Noise

Width: m

Resolution: X pix

Information Limit: x Maximum Frequency RUGEIG

Remove High Frequencies outside the Information Limit

Smooth Edge By: x Information Limit

Background Model: Falils]iUle[CENRS

Enhanced background x random (white) noise std

15 1= 9 Image Trend v
Upsampling by

Fourier Transform Display Mode: © Modulus (Amplitude)
@ Log of Modulus

Width: Size of the local square area.

Resolution When you know the resolution of the micrograph in a
physical unit or in pixels, you can directly input the
value here. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

Information Limit: The Information Limit given by a fraction of the
Maximum Frequency of the image.
Update By clicking the Update button, you can verify the

Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click this button to check the size of
the circle on the power spectrum.
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Remove High Frequencies outside the Information Limit

Smooth Edge By:  If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge).

Background Model: The background of the filter will be estimated from the
amplitude or the intensity.

Mode: The choice of the 2D background estimation scheme
from Quick and Elaborate.

Enhanced background If checked, the background is increased by the factor
(Pro only) multiplied by the std of the random noise.
Subtract: Image trend/Gaussian blurred image

If checked, the image trend or Gaussian blur of the
original image is subtracted before Wiener/ Difference
filtering, and put back afterward.

Upsampling (Pro only) If checked, the filtered image will be up-sampled by
the selected factor.

Fourier Transform You can select the display mode between Modulus

Display Mode (Amplitude) and Log of Modulus.

Local 2D Wiener filtered image Difference from the original image
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3.2 Motif Average

Motif averaging is a real space technique to obtain a noise-filtered image from
an image of periodic structure. Here, we call a small region “motif,” for which
we search similar regions of the same size over the whole image. Then, we will
take an average over the regions with high similarities. Usually, the similarity is
measured by cross-correlation of the image and the motif.

3.2.1 Refine Motif (First cross-correlation)

At first assign the original motif using a Rectangle ROI as shown below:

Next, launch the “Refine Motif” command. Then, the histogram of
cross-correlation of the whole image and the motif will appear.

& G: Peak Histogram_X-corr of Motif With ax1_005_motif o - = HREM Histogram X
1 ' Select threshold and press OK

Min: [0.0  Max: [1.0

No of bins: W
ICanceIl IHome] lAppIy] |

You can change the minimum and maximum values, and the number of bins to
be displayed in the HREM Histogram palette. The found peaks are displayed in
blue, and the peaks above the threshold in red. The peak threshold can be
changed by adjusting the left range of the range ROI.

When you satisfy the thresold setiting, press “OK” in the HREM
Histogram palette. Then, the original motif and the refined motif averaged over
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the selected patches will be displayed as shown below:

Original motie Refined motif ‘
3.2.2 Average good Motifs (Second cross-correlation)

This is the second step of “Motif Averaging,” where the cross-correlation of the
whole image with the refined motif is calculated, and an averaged image over
the good motifs will be finally obtained.

To obtain the averaged image, launch “Average good Motifs”” command when
the “Refine Motif” is a front image. Then, the similar histogram and HREM
Histogram pallet will appear. Adjust the threshold by watching the peak color,
blue or red, over the whole image. If needed, you can change the minimum and
maximum values, and the number of bins in the HREM Histogram palette.

When you satisty the thresold setiting, press “OK” in the HREM Histogram
palette. Then, the averaged image over the good motifs will be displayed as
shown below:

The Fourier transforms below shows obtained from the whole original image
and the averaged image over the good motifs, respectively. Here, you can see
the averaged motif keeps all the periodic information of the original image, and
further shows a bit finer details, which cannot be detected by eyes.
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FT of the whole image

FT of the motif averaged image
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3.3 Realtime Upsampling Filter

The real-time (up-sampling) filter will assist an operator in performing
experiments especially at a low dose condition. This filter can be used to adjust
microscope condition, such as astigmatism and defocus, by looking the sample
itself on the noise filtered image in live.

NOTE: To use the noise filter capability you need the license of the Runtime
Module. However, this tool can be used even when you don’t have the Runtime
license, when you install the HREM-Filters Lite. In this case, however, the
filter selection is set to “None.” Namely, you can use this tool without a filter
capability to display a smoothed image in live by upsampling the selected
image in the view mode.

3.2.1 RT Upsampling Filter Palette

RT Upsampling Filter X
Ak ELEE Update image list
A: untitted v
Upsampling by

T Radial Wiener v

Resolution: EX/EE pix

Enhanced background

x random (white) noise std

£ cIEn

Open the RT Upsampling Filter palette

The Realtime Upsampling Filter palette will be opened by selecting “RT
Upsampling Filter” from Window->Floating Windows, or selecting “Realtime
Upsampling Filter” from the HREM Filters menu.

Select a target image
The target image can be selected from the image pull-down list. If necessary,

the image list can be updated by using “Update image list” button. The target
image may be a STEM image, or a TEM image in the view mode.

TIPS: ROI on the target image

If there is a ROI on the target image, only the area in the ROI is
processed. This capability is very useful for a high frame-rate large TEM
image. The position and the size of the ROI can be changed at any time,
but the filtered image will change only when the target image is updated.

Set the processing parameters

“Resolution” and “Enhanced background factor” are important parameters that
affect the filter performance. Therefore, these parameters should be determined
correctly by using the command: HREM-Filters->Radial Wiener/Difference
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Filter. You can use the latest parameters used by the filter command by the
“Load” button. Conversely, you can store these parameters for a later use by
“Save” button.

When the target image is calibrated, the corresponding scale unit will be
displayed, and you can use a fixed “Resolution” even when the magnification is
changed. Contrary, if the target image is not calibrated, the unit “pix” is
displayed and “Resolution” should be modified manually when the
magnification is changed.

Start the filter

The Realtime Upsampling Filter will be started by pressing the “Start” button.
Then, this button will change to “Stop,” by which you can terminate the
processing.

When the Start button is pressed, a filtered image will be displayed in a
separate window, and be updated when the target image is revised.

NOTE: If the image update is quicker than a required processing time,
some of the frames during the processing will be skipped and not
processed. This will usually happen for a high frame-rate TEM image that
is larger than 512x512 pixels. By using a small ROI, you can decrease the
required processing time and increase a number of frames (fps) that will
be processed.

Off-line use of the Realtime filter tool

You can use this tool for off-line processing, when you select an already
acquired image stack. When you push “Start” for an acquired image stack, the
upsampled image for a current (selected) slice is displayed, and the upsampled
image will be updated when the slice is changed, say by the slice player.

The next figure demonstrates what you can expect from the real-time
noise filter on a live experiment (on-line use). You can observe a crystal
structure even from a single frame with an average dose rate as low as
0.25 el/pix/frame at several frames per second for the ROI of 512 x 512.

Furthermore, the up-sampling capability allow you to use a lower
magnification for image acquisition while observing an up-sampled
smooth image in live, and to examine the image acquisition conditions
and/or the sample area to be acquired.
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This figure illustrates the off-line use of the noise filtering of low dose TEM images of
MOF taken at 300kV (Courtesy of Xiaoxiao Cao, Gatan China.). The left pane (a) shows
an area of 2kx2k pixels acquired with a Gatan K2 camera working at Electron Counting
mode, where consecutive ten frames are accumulated using the slice tool to reveal the
sample feature. The top right pane (b) is an enlarged part of the ROI (512 x 512) in the left
pane. The almost dark inset in (a) shows a single frame of the same region, which does not
show any structure. The histogram in (a) of this single frame indicates that an average
dose rate is as low as of 0.25 el/pix/frame. Surprisingly, the image (c) obtained from this
single frame reveals the crystal structure using this real-time filter. It may be noteworthy
that the noise filtered image (c) of the single frame is better than the accumulated image
(b) over 10 frames.
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3.2.2 Create Upsampled Images

This command will create an unsampled image/image stack from the
observed image/image stack. When create the unsampled image, you can
delete the noise beyond the resolution/information limit.

Create Upsampled Image

Upsampling by

Remove High Frequencies outside the Information Limit

Resolution: pix

Information Limit: x Maximum Frequency

Smooth Edge By: x Information Limit

X

Upsampling

If checked, the filtered image will be up-sampled by
the selected factor.

Remove High Frequencies outside the Information Limit

Resolution

Information Limit:

Update

Smooth Edge By:

When you know the resolution of the micrograph in a
physical unit or in pixels, you can directly input the
value here. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

The Information Limit given by a fraction of the
Maximum Frequency of the image.

By clicking the Update button, you can verify the
Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click this button to check the size of
the circle on the power spectrum.

If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge).
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3.3 Other Filters

3.3.1 Periodic Filter

DigitalMicrograph has a set of mask tools for Fourier filtering. However, it is
not easy to set up a set of base vectors using a Periodic Mask tool for a Periodic
Filter. The commands under this menu will work the Periodic Mask tool of
DigitalMicrograph.

Periodic Filter > Find Base Vectors
Apply Mask... (Pro)

How to use “Periodic Filter”:

1. Specify any lattice points on the base vector directions by using the
Periodic Mask tool.

2. Choose “Find Base Vectors” command when the masked image is at the
front.

3. Adjust a mask size using the Periodic Mask tool.

4. Apply a mask using “Apply Mask...” command under the Process menu or
Periodic Filter menu.

3.3.1.1 Find Base Vectors (Using Periodic Mask tool)

This command will find a precise base vectors for a Periodic Filter.

1. Put the arrowheads of the Periodic Mask tool ay any lattice points on the
directions of two base vectors.

2. (Optional) Put a Point ROI on one spot. The spots on the lines passing
thought the Point ROI will help to find the base vectors.

3. Choose this command when the masked image is at the front, then true
base vectors along the specified direction will be estimated precisely based
on a least-square technique. Please note that user has to specify a set of
correct directions to cover all the lattice points.

4. Make sure the base vectors are correct. If the command fails to find the
correct base vectors, you will get a following message:

DigitalMicrograph

@ Sorry, a eood set of base vectors could not be found.

Then, you may want to try other set of lattice points using the Periodic
Mask tool. Before trying another lattice points, you may also want to try
with the Option (Step 2) using the same lattice points.

5. Adjust a mask size using the Periodic Mask tool.

When an image size is large, Filters Lite will take some time to get a result
compared with Filters Pro.
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Joint ROI

Original image (512x512) (Si3N4: Two lattice points on the base vector

Courtesy of C. Kisielowski) directions selected by using the
Periodic Mask tool. Note an optional
Point ROL.

Base vectors and lattice positions Mask applied by using the Apply Mask
estimated by using this command. command of the Process menu.
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3.3.1.2 Find Base Vectors (Using Mouse tool)

N %} ¥y  This command will find a precise base vectors for Periodic Filtering using the

Mouse tool.

1. Select any lattice points on two base vector directions by using the Mouse

tool.

2. Choose this command when the masked image is at the front, then the
following dialog will appear:

Orders

OK

Mouse Point1: |6
Mouse Point 2: |5

Mask radius: |§ pixel

v Refine Base Vectors

Cancel

r'ﬁ Base Vector @

Here, you have to specify the order of the reflections specified by the

Mouse tool. You can here specify the mask radius. If you check “Refine
Base Vectors,” then true base vectors along the specified direction will be
estimated precisely based on a least-square technique. Please note that
user has to specify a set of correct directions to cover all the lattice points.
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3. Make sure the base vectors are correct. If the command fails to find the
correct base vectors,

DigitalMicrograph @

Q Sorry, a good set of base vectors could not be found.

Then, you may want to try other set of lattice points using the Mouse tool.
4. Adjust a mask size using the Periodic Mask tool.

When an image size is large, Filters Lite will take some time to get a result
compared with Filters Pro.

3.3.1.3 Apply Mask...(Pro Only)

This is an extended version of the command “Apply Mask...” under the
Process menu of DigitalMicrograph. There are several options that will reduce
random noise from the final filtered image.

ti- Apply Mask Options [
Smooth Edge By: | 5.0 pixels
Apply Wiener Filter
Remove Center Spot

Information Limit: | 0.5 X Maximum Frequency

Remove High Frequencies outside the Information Limit

[ OK ][ Cancel ] ‘
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Apply Wiener Filter: Amplitude of the spot is modified by a Wiener estimate

where F is average amplitude around each spot.

Remove Center Spot: Amplitude around the center spot is set to zero except
the origin single point.

Information Limit: The Information Limit given by a fraction of the
Maximum Frequency of the image.
By clicking this button, you can verify the Information
Limit on the power spectrum. When you change the
value of the information limit, click the button again to
check the size of the circle.

Remove High Frequencies outside the Information Limit
If checked, high frequencies outside the Information
Limit will be removed.

Mask applied by using the extended  Filtered image.
Apply Mask command.
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3.3.2 Adaptive Wiener Filter
This command applies a linear filter (local average) to an image adaptively
according to the local image variance. The sizes of a local average and local
variance can be controlled by “Adaptive Average” and “Noise Estimation”,
respectively. If the variance is large, the filter performs less smoothing, while
the variance is small, the filter performs more smoothing.
The adaptive filter is more selective than a simple local average filter,
preserving edges and other high-frequency parts of an image.

i Wiener Filter @

Adaptive Average: [1_ X2+ pixels
Noise Estimation: [1 2+ pixels

oK | Cancel

HREM-Filters Pro/Lite: Image Filter Functions 30



3.4

HREM-Filters Utilities

3.4.1

3.4.2

Replace Dud Pixels

This command will remove dud image points due to bad pixels of a CCD
camera or due to uncontrollable x-ray or cosmic ray. The values of the dud
pixels will be replaced by a local mean. This is an automatic version of Zapper
tool of DigitalMicrograph’s standard tools.

i DigitalMicroera... g]

Tolerance: |4,0
Size: Il 0

oK I Cancel |

The size of a cluster of dud points can be controlled by the Size parameter. The
Tolerance controls a degree of singularity in terms of a local standard
deviation. This will work ideally for small isolated clusters.

For a long connected dud image pixels, an area that includes the dud
pixels may be indicated by a ROI tool manually. Then, the dud pixels
will be replaced by a local mean, when a pixel differs from the local
mean by a specified tolerance times the variance of the area.

Trend Subtract

This command will remove a smoothed trend of an image, and makes a
structural detail to be recognized more clearly. When an image size is large,
Filters Lite will take some time to get a result compared with Filters Pro.

.

Original Image (crysotile) Trend Subtracted imag
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3.4.3 Radial Average

This command will calculate an average profile over the pixels on the same
radial distance from its image center. If the image is complex number such as a
Fourier transform of an image, a modulus will be averaged.

This command will also calculate a standard deviation profile, although the
profile is hidden by default. You can see the standard deviation profile by
choosing “Show std. dev.” on a context menu that will appear by clicking a
right mouse button on the “std. dev.” legend.

260

240 average

200

180

x 1043

60
40
20

o
0.00 0.08 0.0 018 0.20 0.28 0.30 0.35 0.40 045 0.50 058 060 0E6s 070

Radial average profile (Standard deviation profile is set to “show.”)
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4. Filter Description

4.1 Fourier Transform

An observed signal F in Fourier transform may be written as a sum of a true
signal F_ due to a crystal part and a background F, due to a non-crystal
part: F = F_ + F, . If we assume the true signal and the background are

mutually independent, then we may be able to write | F |2 =~ | F. |2 + | Fb|2.

4.2 Wiener Filter

The Wiener filter seeks a solution that minimizes the summed square difference
between the true signal F, and its estimate [ resulting

Foz_‘ﬁbr _Fo
F P o=

o

2 2

-|Af
F

o

F

Fc 2 + | Fb|2 0
where ¢ is the phase of the observed signal F, and fv‘b the estimate
of the background. Here, we assume F_and F, areindependent.

F = l¢0,

c

If |F0|—‘Fb‘s0, F. is set to zero.

4.3 Difference Filter

The Difference filter (the background subtraction filter) is simply given by
ﬁ ¢ = ( F )e i¢0’

where ¢ is the phase of the observed signal F and ﬁ'b the estimate of the

A

_Fb

background. If |F0| - ‘ﬁb‘ <0, ﬁc is set to zero.

Reference: R. Kilaas, J. Microscopy 190 (1998) 45-51.
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4.4 Background Estimation

In order to use either filter we have to estimate a background contribution I:“b.

A radial average background has been commonly used. Here, we propose new
backgrounds.

1. Radial Background

Normally, the background is estimated as a radial average of the Fourier
transform of the whole image assuming that the contribution from amorphous
(non-periodic) materials varies slowly.

Reference: L.D. Marks, Ultramicroscopy 62 (1996) 43-52; R. Kilaas, J.
Microscopy 190 (1997) 45-51.

2. Two-Dimensional Background

A radial background will not work, when structure information appears at the
same distance from the origin in Fourier space. Thus, we developed a novel
approach based on P-spline fitting to estimate a smoothed two-dimensional
background in Fourier space.

Reference: PH.C. Eilers et al., Computational Statistics and Data Analysis 50
(2006) 61-76.

3. Local Two-Dimensional Background

When an orientation of periodic structure is different locally, the background
estimated for the whole image is not adequate. Thus, a set of two-dimensional
backgrounds in Fourier space is estimated by dividing an image into local small
areas.

4. Periodic Mask Background

A periodic mask is frequently applied to a Fourier transform of a lattice image.
We may be able to modify a simple periodic filter to a Wiener type filter,
where a background is estimated for each diffraction spot from a surrounding
area of each mask.
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Quick Reference Guide

The HREM-Filters Main Menu

Local 2D Wiener Filter (Pro)...
2D Wiener Filter (Pro)...
Radial Wiener Filter...

Local 2D Difference Filter (Pro)...
2D Difference Filter (Pro)...

Radial Difference Filter...

Refine Motif (1st xCorr) (Pro)...

Average good Motifs (2nd xCorr) (Pro)...

Realtime Upsampling Filter...

Create Upsampled Image...

Periodic Filter >
Adaptive Wiener Filter...

Find Base Vectors
Apply Mask... (Pro}

Replace Dud Pixels...
Trend Subtract

Radial Average

Help

About Filters...

The commands in the HREM-Filters menu are described below.

Command

Description

Local 2D Wiener Filter

Calculates a Wiener filtered image using 2D local
backgrounds

2D Wiener Filter

Calculates a Wiener filtered image using a 2D
background

Radial Wiener Filter

Calculates a Wiener filtered image using a radial
background

Local 2D Difference
Filter

Calculates a Difference filtered image using 2D local
backgrounds

2D Difference Filter

Calculates a Difference filtered image using a 2D
background

Radial Difference Filter

Calculates a Difference filtered image using a radial
background
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Refine Motif

Calculates a cross-correlation of the whole image with
the given motif, and give a refined motif for the next
command.

Average good Motifs

Calculates a cross-correlation of the whole image with
the refined motif, and give an averaged image over he
good motifs (image patches).

Realtime Upsampling
Filter

Opens RT Upsampling Filter tool, which will assist an
operator in performing experiments especially at a
low dose condition.

Create Upsampling
Image

Creates unsampled image/image stack from the
observed image/image stack.

Periodic Filter
(see sub menus)

Commands to assist/extend Periodic Filter
Find Base Vectors
Apply Mask

Adaptive Wiener Filter

Performs a linear filter (local average) adaptively
according to the local image variance.

Replace Dud Pixels

Replaces dud pixels with a local average
automatically according to the local image variance.

Trend Subtract

Subtracts an image trend (global background)

Radial Average

Calculates a radial average and std. deviation of a
Fourier transform
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Local 2D Wiener/Difference Filter Menu

Filter Options Dialog

Amorphous Noise Tab

Filter Options X

Amorphous Noise [EENTT RN

Width: m

Resolution: EXi) pix

Information Limit: x Maximum Frequency RU[sTeE1C)

Remove High Frequencies outside the Information Limit

Smooth Edge By: x Information Limit

GEMGIGIEA LI Amplitude

Enhanced background x random (white) noise std

S5 =[= Image Trend -
Upsampling by

Fourier Transform Display Mode: Q) Modulus (Amplitude)
@ Log of Modulus

Component Description
Width: Size of the local square area.
Resolution When you know the resolution of the micrograph in a

physical unit or in pixels, you can directly input the
value her. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

Information Limit:

The Information Limit given by a fraction of the
Maximum Frequency of the image.

Update

By clicking the Update button, you can verify the
Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click the button to check the size of
the circle on the power spectrum.

Remove High Frequencies outside the Information Limit

Smooth Edge By:

If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge).

Background Model:

The background of the filter will be estimated from the
amplitude or the intensity.

Mode:

The choice of the 2D background estimation scheme
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from Quick and Elaborate.

Enhanced background
(Pro only)

If checked, the background is increased by the factor
multiplied by the sdt of the random noise.

Subtract: Image trend/Ga

ussian blurred image

If checked, the image trend or Gaussian blur of the
original image is subtracted before Wiener/ Difference
filtering, and put back afterward.

Upsampling (Pro only)

If checked, the filtered image will be up-sampled by
the selected factor.

Fourier Transform
Display Mode

You can select the display mode between Modulus

(Amplitude) and Log of Modulus.
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2D Wiener/Difference Filter Menu

Filter Options Dialog

There are two noise models: Amorphous noise and Random noise.

Amorphous Noise Tab

Filter Options X

Amorphous Noise [EENT] RN

Resolution: EXi) pix

Information Limit: x Maximum Frequency RU[TEIC)

Remove High Frequencies outside the Information Limit
Smooth Edge By: x Information Limit
Show Background
Show Mask

GEMGIGIEA LI Amplitude  ~

Enhanced background x random (white) noise std

S5 =[=9 Image Trend -
Upsampling by

Fourier Transform Display Mode: Q) Modulus (Amplitude)
@ Log of Modulus

Component

Description

Resolution

When you know the resolution of the micrograph in a
physical unit or in pixels, you can directly input the
value her. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

Information Limit:

The Information Limit given by a fraction of the
Maximum Frequency of the image.

Update

By clicking the Update button, you can verify the
Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click the button to check the size of
the circle on the power spectrum.

Remove High Frequencies outside the Information Limit

Smooth Edge By:

If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge).
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Show Background:

If checked, the background of the Wiener/Difference
filter will be displayed.

Show Mask:

If checked, the Wiener/Difference filter mask will be
displayed.

Background Model:

The background of the filter will be estimated from the
amplitude or the intensity.

Mode:

The choice of the 2D background estimation scheme
from Quick and Elaborate.

Enhanced background
(Pro only)

If checked, the background is increased by the factor
multiplied by the sdt of the random noise.

Subtract: Image trend/Ga

ussian blurred image

If checked, the image trend or Gaussian blur of the
original image is subtracted before Wiener/ Difference
filtering, and put back afterward.

Upsampling (Pro only)

If checked, the filtered image will be up-sampled by
the selected factor.

Fourier Transform

You can select the display mode between Modulus

Display Mode

(Amplitude) and Log of Modulus.
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Random Noise Tab

Filter Options X

PTGV G Random Noise

lteration Cycle:
Output @ Every Cycle
@® LastCycle

Resolution: pix
Information Limit: x Maximum Frequency

Low-pass Gaussian Width (Sigma): x Information Limit

Remove High Frequencies outside the Information Limit

Smooth Edge By: x Information Limit
Show Background
Show Mask

ECEMGICIEAGEE Amplitude v
Upsampling by

Fourier Transform Display Mode: © Modulus (Amplitude)
@ Log of Modulus

Cancel

Component Description
Iteration Cycles: This determines the maximum number of iterations
Output: Specifies the cycle of result outputs or the output only
Each xx Cycles at the last cycle.
Last Cycle
Resolution When you know the resolution of the micrograph in a

physical unit or in pixels, you can directly input the
value her. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

Information Limit:

The Information Limit given by a fraction of the
Maximum Frequency of the image.

Update

By clicking the Update button, you can verify the
Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click the button to check the size of
the circle on the power spectrum.

Low-pass Gaussian width

(sigma):

The half-width of the smoothing Gaussian in Fourier
space is specified here. A large Gaussian width
requires a longer iteration.

Remove High Frequencies outside the Information Limit

Smooth Edge By: \

If checked, high frequencies outside the Information
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Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge).

Show Background:

If checked, the background of the Wiener/Difference
filter will be displayed.

Show Mask:

If checked, the Wiener/Difference filter mask will be
displayed.

Background Model:

The background of the filter will be estimated from the
amplitude or the intensity.

Upsampling (Pro only)

If checked, the filtered image will be up-sampled by
the selected factor.

Fourier Transform
Display Mode

You can select the display mode between Modulus
(Amplitude) and Log of Modulus.
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Radial Wiener/Difference Filter Menu

Filter Options Dialog

Dialog Filter Options

Resolution: EXi) pix

Information Limit: x Maximum Frequency QU[GEIS

Remove High Frequencies outside the Information Limit
Smooth Edge By: x Information Limit
Show Background
Show Mask

@ Simple Radial Background (e.g.. Kilaas)
O Advanced Radial Background (Pro only)

Enhanced background (Pro only) x random (white) noise std
Trend Subtract (Pro only)
Fourier Transform Display Mode: © Modulus (Amplitude)
@ Log of Modulus

Upsampling (Pro only) by

Option Description

Resolution When you know the resolution of the micrograph in a
physical unit or in pixels, you can directly input the
value her. Since the resolution may not depend on the
magnification, it is convenient to use this when the
image is calibrated.

Information Limit: The Information Limit given by a fraction of the
Maximum Frequency of the image.
Update By clicking the Update button, you can verify the

Information Limit on the power spectrum.

When you change the value of the resolution or
information limit, click the button to check the size of
the circle on the power spectrum.

Remove High Frequencies outside the Information Limit

Smooth Edge By: If checked, high frequencies outside the Information
Limit will be smoothly attenuated from one to zero
between (Information Limit)*(1- Smooth Edge) and
(Information Limit)*(1+ Smooth Edge).

Show Background: If checked, the background of the Wiener/Difference
filter will be displayed.

Show Mask: If checked, the Wiener/Difference filter mask will be
displayed.
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Radial Background type

The choice of the type of Radial Background.

Simple Radial Background: simple rotational average
of the intensity (e.g., Kilaas).

Advanced Radial Background (Pro only): smoothed
version of the Simple Radial Background. Usually,
this background is far better than the Simple Radial
Background.

Enhanced background
(Pro only)

If checked, the background is increased by the factor
multiplied by the sdt of the random noise.

Trend Subtract (Pro
Only):

If checked, the trend of the original image is
subtracted before Wiener/Difference filtering, and put
back afterward.

Fourier Transform
Display Mode

You can select the display mode between Modulus
(Amplitude) and Log of Modulus.

Upsampling (Pro only)

If checked, the filtered image will be up-sampled by
the selected factor.

HREM-Filters Pro/Lite: Command Reference 44




Periodic Filter Menu

Periodic Filter > Find Base Vectors

Apply Mask... (Pro)

Option

Description

Find Base Vectors

Assists to find a precise base vectors for a Periodic
Filter using the Periodic Mask tool, or using the
mouse tool.

Apply Mask...

Apply a periodic mask with Wiener filter and/or
low-pass filter. This command is available for Pro
only.

Find Base Vectors — Base Vectors Dialog

When two mouse points are placed on the two spots along the two base vectors,
the dialog below will appear.

Dialog

5 Base Vector @

Orders

Mouse Point 1: |i|
Mouse Point 2: |1

Mask radius: |1 0 pixel

|v Refine Base Vectors

oK | Cancel |

Option

Description

Mouse Point 1

The order (index) of the mouse point #1 for the base
vector 1.

Mouse Point 2

The order (index) of the mouse point #2 for the base
vector 2.

Mask Radius

The mask radius for each spot in pixels.

Refine Base Vectors

The base vector can be refined with a least-square
fitting by checking this box. Use this capability except
you intentionally want to use the mouse points without
the least-square refinement.
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Apply Mask Menu - Apply Mask Options Dialog

Dialog iz Apply Mask Options li_hj
Smooth Edge By: W pixels

(V| Apply Wiener Filter

[V|Remove Center Spot

Information Limit: [F x Maximum Frequency

[¥|Remove High Frequendies outside the Information Limit

[ OK ] [ Cancel ]
\ Y

Option Description

Smooth Edge By

The width of smoothing of each spot (same as DM -

Process/Apply Mask command).

Apply Wiener Filter

If checked, Wiener filter is applied to each spot by

estimating the background for the spot.

Remove Center Spot

If checked, the whole mask area of the center spot will

be removed (filtered out)

Information Limit:
Update

The Information Limit given by a fraction of the

Maximum Frequency of the image.

By clicking this button, you can verify the Information
Limit on the power spectrum. When you change the
value of the information limit, click the button again to

check the size of the circle.

Remove High Frequencies outside the Information Limit

If checked, high frequencies outside the Information

Limit will be removed.

Adaptive Wiener Filter

Dialog w5 Wiener Filter @
Adaptive Average: [17 x2+1 pixels
Noise Estimation: [1™ 2+ pixels
oK | Cancel |
Option Description
Adaptive Average Defines an area of local average

Noise Estimation

Defines an area for local variance estimation
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Replace Dud Pixels

Dialog “ DicitalMicroer: \@]
Tolerance: [40
Size: [r
oK | Cancel |
Option Description
Tolerance Controls a degree of singularity in terms of a local
standard deviation
Size The size of a cluster of dud points.
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